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appendix

b

If your Mac came with Mac OS 9 already installed, great; you won’t have to go
through the educational but time-consuming process of updating your operat-
ing system. (You may still want to consider reading about the clean install, de-

scribed at the end of this chapter, because it’s a sensational troubleshooting technique.)

If your Mac is running some earlier version of the Mac OS, however, and you’ve
obtained a copy of the Mac OS 9 CD-ROM, almost all of this chapter pertains to
you. It covers all three kinds of installation:

• The standard installation, in which your existing System Folder is simply up-
dated to Mac OS 9, in the process preserving your preferences files, font collec-
tion, A menu configuration, and so on;

• The custom installation, in which you install only the Mac OS 9 components
you want; and

• The clean installation, in which the Mac OS 9 installer gives you a virginal, clean,
complete Mac OS 9 System Folder, setting aside and retiring your existing, older
System Folder.

Tip: Technically, Mac OS 9 costs $99; you can buy it at the computer store, from the Apple Web site
(www.apple.com), or from any Mac mail-order joint (such as macwarehouse.com, macmall.com, or
maczone.com). But Apple will give you a $20 rebate if you have Mac OS 8.5 or Mac OS 8.6. And if you
have an iBook, Power Mac G4, or any other Mac model that was released after Mac OS 9, you can buy Mac
OS 9 for $20. For details on these offers (which involve mailing in a considerable amount of paperwork),
call 800-335-9258, or visit www.apple.com/macos/uptodate.

Installing Mac OS 9



424 mac os 9: the missing manual

Before You Install
Mac OS 9 requires a Mac with a PowerPC processor, which includes every Mac sold
since late 1994. PowerPC-equipped Macs include every Power Macintosh, iMac, and
iBook model, along with any Performa, PowerBook, or LC model with a four-digit
model number. (You can’t install Mac OS 9 on a Mac model that you’ve enhanced
with a PowerPC upgrade card.)

Mac OS 9 also requires a Mac that has 32 MB of RAM and virtual memory (see page
117) turned up to at least 40 MB. For faster, smoother operation, however, Apple
recommends 64 MB of memory or more. You need 100 to 250 MB of empty disk
space when you install Mac OS 9, too, depending on how many of its components
you plan to install.

If you’re upgrading from Mac OS 8.1 or earlier, consult the Before You Install docu-
ment on the Mac OS 9 CD. It contains special steps for Macs with ultrawide SCSI
cards, DOS compatibility cards, and Macs in the 5000 and 6000 model lines. It also
warns you about hard drives that you’ve formatted using non-Apple hard drive soft-
ware (such as HDToolkit); you’ll probably have to contact the manufacturer about
getting an update before you can install Mac OS 9.

The Standard Installation
If you’re upgrading to Mac OS 9 from an earlier Mac OS version, Apple assumes
that you’ve already got a lot of customized stuff in your existing System Folder:
fonts you’ve added, extensions and control panels deposited by your application
installers, the preference files that store serial numbers for your software, A menu
items you’ve installed, and so on. The idea behind the standard Mac OS 9 installa-
tion is to preserve all of that customized stuff. Mac OS 9 installer treads carefully
around it, updating or adding only the components it cares about—the ones needed
to give you a genuine Mac OS 9 System Folder.

Most people, most of the time, perform this kind of upgrade. There is another way
to install Mac OS 9—the clean install, described later in this appendix—but the
standard installation is the one you get if you don’t take any special steps.

Most Mac OS 9 upgrades go very smoothly. Still, when things do go wrong, the
standard installation is generally at fault. That’s because some of your older exten-
sions, control panels, and other System Folder components—the very items the Mac
OS installer takes care not to disturb—may be incompatible with Mac OS 9. When
you start up the machine after the installation, therefore, your first experience with
the new operating system may be freezes or other glitches.

The bottom line: If things go well, the standard installation can save you a lot of
time and hassle. It simply upgrades your existing System Folder, maintaining your
customizations. If things don’t go well, and your Mac is crashy after the upgrade,
you can always perform a clean install afterward. Consider jumping directly to a
clean install only if:

Before You Install
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• You’re having glitches and freezes already, while running your older system soft-
ware. Installing Mac OS 9 over such a system would simply exacerbate the prob-
lems.

• You’re a utility junkie. You’ve loaded down your System Folder with add-on ex-
tensions and control panels, such as Kaleidoscope and other shareware goodies
from the Web. If so, you’re probably better off performing a clean install—unless
you first revisit the Web sites in question to make sure you’ve got the latest, Mac
OS 9-compatible versions of your System Folder clutter.

Here, then, are the steps for performing a standard installation.

Tip: If you’re installing Mac OS 9 onto a laptop, plug it in before you begin, so that it won’t go to sleep or
run out of battery power in the middle of the process. Check your Energy Saver control panel, too, to make
sure that the computer isn’t set to sleep after only a few minutes of inactivity.

1. Insert the Mac OS 9 CD-ROM. Choose Special→Restart; immediately hold down
the letter C key until you see the light-colored desktop pattern that’s filled with
pictures of CDs.

That special background tells you that you’ve started up the Mac from the CD-
ROM. (Technically, you can install Mac OS 9 without starting up from the CD-
ROM, but this approach is more likely to go smoothly. It rules out the possibility
that one of your own extensions or control panels might interfere with the in-
stallation process.)

On the screen now, you should see the Mac OS 9 CD window. It contains Before
You Install, a Utilities folder, and the Mac OS Install icon.

Figure B-1:
The Select Destination
screen that lets you
specify which disk you
want to receive Mac OS 9.
It’s possible to cram Mac
OS 9 onto a Zip disk, but
only if you use a
customized installation,
as described in the next
section, and request only
a few of Mac OS 9’s
features—and then use
the Memory control
panel’s “Select Disk” pop-
up menu to specify a
different disk for virtual-
memory storage.
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2. Double-click Mac OS install.

A welcome screen appears. There’s nothing particularly interesting on it except
for the circled question mark in the upper-right corner, which you can click for
some help screens.

3. Click Continue (or press Return).

Now the Select Destination screen appears, as shown in Figure B-1. This is where
you’re supposed to specify which disk you want Mac OS 9 installed on. Most people
accept the proposed choice, which is the built-in hard drive. It’s possible, however,
to install Mac OS 9 onto a different drive, such as an external hard drive, a Jaz
cartridge (if you have version 6.0.2 or later of its driver software), and so on.

4. From the Destination Disk pop-up menu, specify the disk on which you want
Mac OS 9 installed. Then click Select (or press Return).

Now you’re shown the Before You Install document; it’s the same one that ap-
pears in the Mac OS 9 CD window.

5. Click Continue (or press Return). Click Continue on the next screen, too, to
bypass the software license agreement. Click Agree on the pop-up warning.

At last you arrive at the Install Software screen. At this point, you could click
Options to turn off one of two special features: Update Apple Hard Disk Drivers
makes sure that your hard drive (if it’s an Apple hard drive) has the latest hard
drive software installed—an excellent idea. The Create Installation Report
checkbox produces a folder on your hard drive called Installer Logs; inside are
text files that identify every software component the Mac OS 9 installer added,
deleted, or replaced.

This screen also contains the Customize button. More on this topic in “The Cus-
tom Installation,” later in this appendix.

6. Click Start.

If you’re warned that other applications are running, click Continue. (The Mac
can’t install new system software if any other programs are running.)

Now the installation process begins in earnest. A status box lets you know what’s
going on—first the installer checks your hard drive and automatically repairs
any damage it finds there. (This step makes the transition to Mac OS 9 much
smoother than, say, the one to Mac OS 8, whose installer didn’t perform this
check. The upgrade to Mac OS 8 caused grief for thousands of people who had
tiny problems lurking on their hard drives.)

Next, the installer updates the driver software on your hard drive (unless it’s not
an Apple hard drive, in which case you’re responsible for obtaining Mac OS 9-
compatible driver software).

Finally, the actual software installation begins. You can click Cancel at any time;
you’ll be asked whether you want to abort the entire installation, just skip the
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installation of the component currently being installed (such as ColorSync or
speech recognition), or start the installation over again.

The entire installation process takes about 10 minutes. When the installation is
complete, you’ll be asked to restart the Mac.

7. Click Restart.

That’s it—you’ve just installed Mac OS 9.

When the Mac starts up again, the Mac OS Setup Assistant runs automatically; it’s
an inconsequential startup program designed primarily for people whose Macs are
connected to office networks. On successive screens, you’re asked to specify the cur-
rent time zone, the current time and date, your name and password (for networking
purposes), what kind of printer you plan to connect, and so on.

Figure B-2:
If you click Customize,
you’re offered these
primary 10 chunks of
software (top). If you
choose Customized
Installation from one of
the pop-up menus at the
right side of that window,
you’re shown the
individual software pieces
that make up the larger
module (bottom). A
checkmark means you’re
going to get the entire
collection; a – means that
you’re going to get some
of the items within each
collection; and an empty
checkbox means you’re
not going to get any of
the items in that
collection. Click the little i
button for a terse
explanation of its
contents.
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Tip: You can skip the Mac OS Setup Assistant; just choose File→Quit at any time, and then confirm that
you do indeed want to abandon the process. If you’re not on office network, the only meaningful setting
the Setup Assistant makes for you is the time and date, which you can do much more quickly yourself (by
choosing A→Control Panels→Date & Time).

On the final screen, you can click Quit (to begin using your Mac) or Continue (if
you’d like to set up an Internet account). If you choose to continue, you’re shown
the Internet Setup Assistant, which walks you through the process of setting up an
Internet account with EarthLink.

Then, at last, you’re ready to begin using your Mac and enjoying the features de-
scribed in this book.

The Custom Installation
In step 5 of the preceding instructions, you come face-to-face with a button called
Customize. It brings up the screen shown in Figure B-2, where you can specify which
components of the Mac OS you want installed. Unless you’re an absolute terrified
novice who’d just as soon not have to confront unnecessary options, turning off the
components you don’t need can save you installation time and a lot of disk space.
This option lets you order your software meal à la carte instead of as a fixed package.

To the right of each item is a pop-up menu. (You must turn on the checkbox to un-
dim the pop-up menu.) It lets you further break down this customized installation
into the individual chunks of software that make up each of the modules listed here,
as shown in Figure B-2.

Here are the individual modules you can turn off or on—and the sub-options that
appear when you choose Customized Installation from the pop-up menu:

Mac OS 9
This item gives you the basic System Folder, lacking only the nine other major mod-
ules items listed on this screen. If you choose Customized Installation from the pop-
up menu to its right, you discover that Mac OS 9 is composed of these elements (see
Figure B-2, bottom):

• Core System Software. Here it is: Mac OS 9 in its tiniest, most stripped-down form—
a mere 18-MB chunk that’s just barely enough software to let your Mac turn on.
This option is useful when you want to create, for example, an “emergency” Zip
disk or even RAM disk, so you’ll have something to start up your Mac when all else
fails (and you’ve lost your Mac OS 9 CD, which is an ideal startup disk).

This miniature System Folder is rather shocking to use: it starts up your Mac
almost instantaneously, seems to double your Mac’s speed, and uses very little
RAM. Of course, it’s lacking just about every useful feature of the standard Mac—
in fact, it gives you only a single font (Geneva), which makes your menus look
extremely peculiar.

The Standard
Installation
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Tip: Don’t miss the Selection pop-up menu above the list of checkboxes (you can see it in the bottom
dialog box of Figure B-2). It lets you turn all of the checkboxes on or off with a single click.

• Assistance. This item means “help files,” including two of the help systems (Apple
Guide and Mac OS Help) described in Appendix A, the Mac OS Setup Assistant
program described above, and SimpleText.

• Compatibility. Grants you File Exchange (a control panel described in Chapter 12)
and Locale Support. Locale Support creates a folder in your System Folder called
Language & Region Support, containing 13 resource files for various languages.
The Mac relies on the information in these files when it offers you various interna-
tional choices in its control panels, such as Date & Time, Numbers, and so on.

• Mobility. These programs for laptops include Apple IR File Exchange (lets
PowerBooks connect with each other through the air, via infrared communica-
tion), a battery-draining application (designed to eliminate the “memory effect”
of very old PowerBook batteries), the Trackpad control panel, and the drivers for
various PowerBook and iBook modems and monitors.

• Multimedia. In this category are the drivers for various Apple sound and video
products, including its CD/DVD drive, game drivers like OpenGL and Game
Sprockets, QuickTime, and the useful AppleCD Audio Player (see Chapter 5).

• Network & Connectivity. Most of these items are for setting up an office net-
work, as described in Chapter 16: AppleShare, Ethernet drivers, File Sharing, the
Network Browser, Open Transport (see Chapter 14), and so on. Buried in this
option, however, are several of the big-ticket Mac OS 9 features—the Multiple
Users control panel, the password-encryption feature, and so on.

• Printing. This batch includes all the software described in Chapter 15—various driv-
ers for discontinued Apple printer models, the Desktop Printing software, and so on.

• Universal Access. You can read about these two control panels—CloseView and
Easy Access—in Chapter 13.

• Utility. This broad category includes some of the most useful Mac OS 9 compo-
nents: AppleScript (Chapter 10), the application switcher (Chapter 6), the Con-
trol Strip (Chapter 4), Disk Copy (Chapter 13), Disk First Aid (Chapter 13), Drive
Setup, FontSync (Chapter 12), the Graphing Calculator (Chapter 13), Note Pad
(Chapter 13), SimpleSound (Chapter 20), and so on.

• Video. Here are the drivers for various Apple monitors, plus the DigitalColor
Meter program described in Chapter 13.

• International. This software gets your Mac ready for the international language
features described in Chapter 13.

• Apple Menu Items. Here are the Calculator, Chooser, Key Caps, Sherlock, and
other A menu items that aren’t part of the bundles of software described so far.

The Custom
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• Control Panels. This category includes all of the control panels described in Chap-
ter 12—except the ones included in software chunks described so far.

Tip: Nestled among these control panel options is File Synchronization, which is generally installed only
on laptops. If you have a desktop Mac, you can use a custom installation to turn it on here.

• Fonts. Using these checkboxes, you can turn on or off each of the 19 TrueType
fonts that come with the Mac (see Chapter 19).

Internet Access
A better name for this item would have been “Internet programs,” because this is the
component that gives you two Web browsers (Internet Explorer and Netscape Com-
municator), an email program (Outlook Express), and so on. If you use the pop-up
menu to specify Customized Installation, you may save yourself a lot of disk space;
the individual components you can turn on or off include:

• Apple Internet Access. This checkbox refers to the Internet Access extension, which
you need to go online.

• Internet Utilities. This item grants you StuffIt Expander, the useful utility pro-
gram that can decompress software you download from the Internet via email or
Web pages, and DropStuff, which lets you create compressed files for sending.
(Most email programs perform this compression automatically, however.)

The Universal System Folder
When you install the Mac OS 9 component by itself, the
installer gives you a System Folder that can start up your
Mac model. Unbeknownst to most Mac fans, however, not
every Mac OS 9 System Folder is alike. The installer can
create several subtly different versions of Mac OS 9—one
for an iMac, another for Power Mac G4 models, another for
the old beige Power Mac G3 models, and so on.

In other words, the Mac OS 9 you installed onto a Zip disk
connected to your iMac may not actually be able to start up
a Power Mac G3 in the next office.

The solution: create a Universal System Folder. This extra-
large version of Mac OS 9, once installed on a portable disk

large enough to contain it, can power up any Mac OS 9-
compatible machine.

To create it, run the Mac OS 9 installer, exactly as described
in steps 1 through 5 at the beginning of this appendix. Once
again, you’ll wind up facing a Customize button. Click it,
make sure the Mac OS 9 checkbox has a checkmark, and
then—from the Installation Mode pop-up menu—choose Cus-
tomized Installation. Finally, from the Selection pop-up menu
above the checkboxes, choose Universal Installation.

Unless you further customize the installation by turning off
some of the checkboxes described below, you’ll get a Sys-
tem Folder that occupies 140 MB—but that can start up any
PowerPC Mac with enough RAM for Mac OS 9.

GEM IN THE ROUGH
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Tip: Newer versions of both StuffIt Expander and DropStuff are already available, at no charge, from
www.aladdinsys.com.

• Microsoft. Turn on this checkbox to acquire Internet Explorer and Outlook Ex-
press, Microsoft’s Web browser and email program.

• Netscape Communicator. An alternative, faster Web browser with fewer brows-
ing features—but a built-in Web-page editor.

Apple Remote Access
This bundle includes the Apple Remote Access Personal Server software, which lets
you dial into your Mac from the road (see Chapter 16).

Personal Web Sharing
As described in Chapter 14, Web Sharing lets you make one folder on your hard
drive available to the entire Internet. This package includes the necessary control
panel, Control Strip module, extension, and instruction manual (in Web-page for-
mat; you’ll find it in a folder called Web Pages on your hard drive).

Text-To-Speech
If you want your Mac to be able to read your text back to you out loud, in a nasal
voice, this is the option you want (see Chapter 21).

Mac OS Runtime for Java
You can read about Java on page 217; it’s a fancy programming language required by
some Web pages (such as banking and game sites).

ColorSync
As described in Chapter 19, ColorSync is a collection of software components that
help ensure color consistency throughout the scanning, viewing, editing, and print-
ing process. This bundle gives you that software, including the Photoshop plug-ins
described in Chapter 19 and the profiles for many Apple color products.

English Speech Recognition
Here’s the software you need for the Mac to understand your spoken commands, as
described in Chapter 21. It’s not ordinarily installed; a customized installation is the
only way to get it.

Language Kits
You can read about these kits in Chapter 13; they let you word process or surf the
Web in any of dozens of different languages—Hebrew, Japanese, Korean, Chinese,
and so on—complete with foreign-language fonts and alphabet systems.

The Custom
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Network Assistant Client
Network administrators can buy a program called Apple Network Administrator
that lets them install software onto an entire network’s worth of Macs—remotely,
from one central computer. Administrators can also maintain the software, trouble-
shoot problems, and even see what’s on your screen. But to do that, your Mac must
have this special software installed.

Tip: You can also remove selected components from an existing copy of Mac OS 9. Suppose, for example,
that in reading the preceding pages, you become alarmed at how much junk gets installed during a
standard installation. By following the steps for performing a customized installation, and then choosing
Customized Removal from one of the pop-up menus (shown at top in Figure B-2), you can turn on the
checkboxes of software components you want removed, thus saving a lot of disk space.

Finally, open the more detailed list of components shown at bottom in Figure B-2. Click the ones you want
deleted, and then click Remove. When the process is over, you’ll be asked to restart your Mac, just as
though you had installed something.

The Clean Installation
A standard Mac OS 9 installation packs in Mac OS 9 around your fonts, control
panels, A menu items, startup items, and so on. If all goes well, when your Mac
restarts after the installation, you’ll be running the new operating system with all of
your familiar modifications intact.

Labeling the Mac OS 9 Components
Regardless of the kind of Mac OS 9 installation you per-
form, one syndrome will befall you in the coming months:
over time, you and your applications will deposit more files
into the System Folder. As you install programs, your Exten-
sions and Preferences folders will collect more accompany-
ing modules; as you explore the Internet, you’ll stumble
across more shareware that sounds like fun. And then one
day, your Mac will start acting up. You’ll stare hopelessly at
your System Folder, filled as it is with over 2,000 icons, and
have no idea where to begin your troubleshooting.

If you plan ahead, you can avoid this situation. Immediately
after installing Mac OS 9, use the icon-labeling trick described
on page  40. The routine goes like this: open your System
Folder. Choose Edit→Select All. Then press C-Option-right
arrow, which expands every flippy triangle so that you can
see every icon in every folder.

Now choose Edit→Select All again, and then choose
File→Label→Essential (or any label you prefer). (You may
even want to choose Edit→Preferences→Labels and type
in a very specific label, such as “Clean install 8/2000.”) You’ve
just tinted every icon in every System Folder folder orange
(or whatever color that label represents). Finally, press C-
left arrow to collapse all the folders again, and close the
System Folder.

When the day of troubleshooting arrives, you’ll be able to
narrow down your list of culprits instantly. You’ll open your
System Folder and look for items that aren’t orange. These
are the icons that didn’t come from Apple, and are there-
fore the ones most likely to be causing your problems. (Be
alert, however: System components that Mac OS 9’s Soft-
ware Updates control panel have automatically downloaded
and installed won’t be orange, either.)

POWER USERS’ CLINIC
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But if anything goes wrong, and your Mac behaves oddly—whether at the time of
installation or later—you may want to consider a clean installation. In this special
mode, the Mac OS 9 installer gives you a new System Folder—a fresh, perfect, smoothly
operating System Folder that doesn’t contain any of the junk you’ve added to your
Mac over the months. Nothing else on your hard drive is disturbed—your programs
and documents are just fine—but the System Folder itself is surgically replaced.

When you do a clean installation of Mac OS 9, the installer retires your existing
System Folder and renames it Previous System Folder to avoid confusion. Figure B-3
shows the effect.

It’s impossible to overstate the power and usefulness of the clean install. Unless your
Mac has actual hardware problems, whatever glitch you’ve been experiencing, in
any program—crashes, freezes, cosmetic anomalies, or whatever—goes away after a
clean install. That’s why this technique is so adored by Mac phone staff, trouble-
shooters, and consultants the world over.

What makes a clean install inconvenient, however, is that when it’s over, you have to
hand-install every component that made the old System Folder your System Folder—
all of those preference files, fonts, A menu items, and so on that you and your pro-
grams had added over the months. This section gives you guidance both on per-
forming a clean install and on performing this follow-up procedure.

Performing a Clean Installation
To give yourself a fresh, new System Folder, follow these steps:

1. Insert your Mac OS 9 CD-ROM. Double-click the Mac OS Install icon.

The Welcome screen appears.

2. Click Continue; from the pop-up menu, choose a destination disk for the
installation.

In general, this is your built-in hard drive.

Now you’ve arrived at the critical step:

3. Click the Options button in the lower-left corner of the window.

As shown in Figure B-4, you’re now offered the chance to specify a clean installation.

Figure B-3:
Your new, fresh Mac OS 9 System Folder is easily identifiable—it’s the one now
called System Folder, and it’s also the one bearing the traditional Mac OS logo,
as shown here at right.
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4. Turn on the “Perform Clean Installation” checkbox and then click OK. Click
Select, and then continue with step 5 on page 426.

When the installation is complete, you’ll see two System Folders—as shown in Fig-
ure B-3—one of which is named Previous System Folder. That’s your old one. You
should notice that the Mac starts up faster, windows and programs open faster, and
the entire machine feels smoother and more responsive.

Reinstalling Fonts, Preferences, and Other Components
If you have a current version of the commercial program called Conflict Catcher
(www.casadyg.com), bringing over your fonts, preference files, control panels, A menu
items, and other personal items from the Previous System Folder into the new one is
easy. The Clean Install Merge command in Conflict Catcher automatically prepares
for you a list of each item in the old System Folder that isn’t in the new one. You just
click the checkboxes of the ones you want copied into the new System Folder, and
call it a day.

If you don’t have Conflict Catcher, you can perform the same steps manually, al-
though you’ll spend more time doing it. Here’s how to go about it:

1. Open the Previous System Folder and the new one in tall, skinny windows, side-
by-side, as shown in Figure B-5.

For each window, choose View→as List.

2. In each of the two windows, click the flippy triangle next to the Apple Menu
Items folder, so that you can see its contents.

The idea is that you want to compare the contents, to find elements in the left-
side (Previous System Folder) window that aren’t in the new System Folder. When
you find such an icon in the Apple Menu Items folder, do this:

Figure B-4:
Click Options (back-
ground) to summon the
“Perform Clean
Installation” dialog box,
which briefly explains
what’s about to happen.
Turn on the checkbox and
then click OK.
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3. While pressing Option, drag each unique icon in the left-side Apple Menu Items
window into the corresponding folder in the right-side window (the new Sys-
tem Folder).

Option-dragging creates a copy of the original. You’re copying, rather than mov-
ing, these items in order to leave your previous System Folder intact, just in case
you need to go back to it.

Incidentally: an item in your A menu can’t cause instability on your Mac. You’re
perfectly safe copying these items into the new System Folder.

4. Repeat the compare-and-copy procedure with the Control Panels, Extensions,
Startup Items, and Fonts folders.

Be judicious, however. The last thing you want is to re-introduce problem com-
ponents into your new System Folder. If possible, install fresh versions of these
control panels, extensions, and fonts—updated versions, if you can find them—
instead of copying them from the old System Folder.

If you find something in the Previous System Folder window that you can’t iden-
tify—that is, you’re not sure whether you need it or not—consider living without
it as you get used to your new System Folder. Part of the joy of the clean install is
leaving behind hundreds of arbitrary files installed unnecessarily by your vari-
ous applications.

Figure B-5:
Set up your old and new
System Folder windows so that
you can compare their
contents. Pay special attention
to the Apple Menu Items,
Control Panels, Extensions,
Fonts, Preferences, and Startup
Items folders. Each time you
recognize something worth
bringing over into your new
System Folder, Option-drag it
from the left window into the
corresponding locations of the
right window.
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5. Repeat the compare-and-copy procedure with your Preferences folder.

Corrupted preference files are a common cause of problems on the Mac. You
should grow especially suspicious when you begin having problems in one specific
program, as described in Appendix C.

Therefore, consider dragging preference files from your old System Folder into
your new one only if they contain key information, such as the password or serial
number necessary to run a particular program. (Unfortunately, some programs
rely on invisible serial-number files; you’ll have to reinstall such programs from
scratch.) You should also copy over the files that contain your Internet connec-
tion information (phone numbers, passwords, and so on)—namely, the TCP/IP
Preferences, Modem Preferences, and Remote Access folder.

Tip: The Mac won’t let you replace the Remote Access folder in your new System Folder; it will claim that
the existing Remote Access folder is “in use.” The solution: throw away the new Remote Access folder
before Option-dragging the old one.

6. Close all windows, and then restart the Mac.

With luck, you’ll be exactly where you want to be: running a clean, fresh, fast new
System Folder that nonetheless contains your most treasured fonts, control panels,
and so on.

At this point, it’s a good idea to live with both System Folders on your hard drive for a
couple of weeks. (Contrary to the Apple advice of the 1980s, these days, it’s perfectly
safe to have multiple System Folders on your hard drive. The Mac “blesses”—activates—
only one System Folder at a time, as indicated by the Mac OS logo on the folder.) After
some time has elapsed, and you’re comfortable that your new System Folder works the
way you like, you can throw away the one called Previous System Folder.

Tip: If the installation didn’t go well, you can always return to your earlier System Folder, even if it was an
earlier version of the Mac OS. To do so, open your new System Folder. Move the Finder out of the win-
dow—to the desktop, for example. Doing so cripples the new System Folder; you’ll see the Mac OS logo
disappear from its folder, and the colorful special folder designs inside it all turn plain.

Now just open and close the Previous System Folder to make the Mac OS logo reappear on it. You’ve just
“blessed” the older System Folder; when you restart, it will be in control. (You can leave its “Previous”
name, or rename it; the name of the System Folder makes no difference.)

Mac OS 9 Compatibility Problems
A major system-software upgrade always invites a few headaches, and Mac OS 9 is a
prominent example. Dozens of programs—especially utility programs—require
minor upgrades to be compatible with Mac OS 9. Not every item in this list, by the
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way, is completely broken in Mac OS 9; some have only minor incompatibilities.
Here’s a partial list of the programs that have compatibility issues, along with the
software companies’ Web sites and the lowest version number that works completely
in Mac OS 9:

Mac OS 9 Compatibility Problems
Product Web site Requires version
Acrobat Reader adobe.com 4.0
Adobe Type Reunion adobe.com 4.5.2
AppleWorks 5 apple.com 5.0.4
ATM adobe.com 4.5.2
Avara Ambrosiasw.com 1.0.1
Barrack Ambrosiasw.com 1.0.4
Conflict Catcher casadyg.com 8.0.6
Cythera Ambrosiasw.com 1.0.4
Excel 98 microsoft.com (unnumbered updater available)
Final Cut Pro apple.com 1.2.1
Final Draft finaldraft.com 5.0.2d
Fourth Dimension acius.com 6.5.3
InstallerMaker aladdinsys.com 6.5
Kensington trackballs kensington.com 5.31
MenuFonts dublclick.com (no fix yet)
Norton Anti-Virus symantec.com 6.0
Norton Utilities symantec.com 5.0
PaperPort visioneer.com (unnumbered updater available)
Premiere adobe.com 5.1c
RAM Doubler 8 connectix.com 9
Retrospect dantz.com 4.2
SpaceSaver aladdinsys.com (no fix yet)
Speed Doubler connectix.com (no fix yet)
StatView statview.com (fixed by the Mac OS 9.0.2 update)
StuffIt Deluxe aladdinsys.com 5.5
StuffIt Expander aladdinsys.com 5.5
StyleWriter 4000 apple.com (no fix yet)
Toast adaptec.com (no fix yet)
VirtualPC connectix.com 2.1.2

You can find much more exhaustive Mac OS 9 compatibility lists at any of these
Web sites:

• MacFixit. Point your browser to www.macfixit.com/reports/macos9-2.shtml#
updated for a long list of updates and software patches, with links.

• Macintouch. The Mac OS 9 compatibility report is at www.macintouch.com/
m90_compatibility.html.

• VersionTracker. This outstanding resource tracks current versions of everything
Mac-related. It has a special Mac OS 9 page at www.versiontracker.com/systems/
system9.shtml.
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